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Find your information

Synology publishes a wide range of supporting 

documentation.

In Knowledge Base, you will find useful Help and 

FAQ articles, as well as video tutorials breaking up 

processes into handy steps.

In Synology Documentation, you can find User's 

Guides, Solution Guides, brochures, and White 

Papers. Experienced users and administrators 

will find answers and guidance in technical 

Administrator's Guides and Developer Guides.

Got a problem and unable to find the solution in 

our official documentation? Search hundreds of 

answers by users and support staff in Synology 

Community or reach Synology Support through 

the web form, email or telephone.

https://www.synology.com/en-global/support
https://www.synology.com/en-us/knowledgebase/DSM/help
https://www.synology.com/en-us/knowledgebase/DSM/tutorial
https://www.synology.com/en-us/knowledgebase/DSM/video
https://www.synology.com/en-us/support/documentation?query=&type=All&section=All&p=1
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https://www.synology.com/en-us/support/documentation?query=&type=whitepaper&section=All&p=1
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https://community.synology.com/enu
https://community.synology.com/enu
https://www.synology.com/en-us/company/contact_us
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Introduction

Overview

Transaction devices record details of each transaction activity and are commonly used in 

various commercial establishments such as restaurants and shops. However, recording 

transaction text alone is insufficient when a dispute occurs during a transaction activity. In 

addition to using transaction devices, setting up security cameras allows owners or other users 

to understand precisely what occurred during each transaction.

However, due to the difference in time settings across different devices, most store owners 

spend a significant amount of time and effort matching recorded transaction text with relevant 

video footage. Synology offers a solution to this challenge by introducing the integration of 

transaction devices and security cameras in Surveillance Station. Security feeds are recorded 

automatically when a transaction occurs, and transaction text or data will be saved with the 

corresponding video clip, bringing more convenience while reducing effort.

The Transactions application in Surveillance Station provides a general raw data receiving 

interface. Aside from supporting common transaction devices such as POS (Point-of-Sales) 

devices, Surveillance Station is also compatible with devices that produce raw data. Once 

Surveillance Station receives raw data, transaction text will be overlaid on the video images 

from the paired cameras. This technology can also be ideal for monitoring production lines in 

factories or other similar settings.

You can pair transaction devices with cameras in Surveillance Station. Please find the following 

key features of combining transaction devices with cameras:

•	 Overlay transaction text on the video images from the paired camera upon receiving raw 

data in Surveillance Station. You can monitor the entire transaction process by watching 

video feeds and reading the transaction data simultaneously.

•	 Record videos automatically upon receiving raw data in Surveillance Station, while 

transaction text is saved with the corresponding video clips, expediting the process of 

investigating transaction activities or evaluating work performance at the cashier. 

•	 Search transaction records quickly by setting filter conditions such as date and time, or by 

searching specific keywords.

•	 Download a report in html format including camera snapshots from recordings and the 

recorded transaction text.

•	 Receive notifications with camera snapshots attached when certain transactions occur.

•	 Trigger action rules and live view alerts when a transaction string matches a specific text.

Introduction
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Compatibility of Synology Transactions

Basic integration methods

Surveillance Station is compatible with devices that transmit data by network or COM port. 

If your device transmits data using one of the two interfaces, you can set up your device 

in Surveillance Station. There are three ways Surveillance Station receives raw data from a 

transaction device:

•	 TCP: Set up an IP address and port to receive data over TCP connection. Note that 

Surveillance Station only receives data as a TCP client. The received raw data are the contents 

above TCP including the package headers.

•	 Serial Port: Receive data via COM port (RS232). Note that this option is only available if your 

NAS comes with a COM port interface. Currently, only the NVR model NVR1218 supports this 

interface.

•	 Surveillance Station WebAPI: Receive raw data using Surveillance Station WebAPI. For 

more information, please refer to the section on How to use WebAPI to send transactions.

Special integration

Integration with the AXIS Barcode Reader can be used to monitor factory production lines or 

used during checkouts in supermarkets to monitor transactions along with video recordings. 

However, only AXIS cameras support AXIS Barcode Reader. For more information on AXIS 

Barcode Reader, please refer to the FAQ in the Synology official website.

License

One transaction device will be counted as one device when calculating the maximum number 

of supported devices for each NAS model, however two device licenses will be required to 

set up a transaction device in Surveillance Station without pairing it with a camera. Including 

a paired camera to the setup will require an additional device license. Please refer to the 

following scenarios:

•	 To receive transaction data, 2 licenses will be required to set up 1 transaction device in 

Surveillance Station.

•	 To overlay transaction data on the video images from a paired camera, 3 licenses will be 

required to set up 1 transaction device and 1 paired camera in Surveillance Station.

http://sy.to/bctutor
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This chapter introduces how to add transaction devices in Surveillance Station, and contains 

complete instructions for hardware and software installation.

Connect Transaction Devices to NAS

Communication with transaction devices in Surveillance Station are done using three methods: 

TCP, serial ports, and WebAPI. TCP and WebAPI sends data over the Internet, while the serial 

port sends data via a COM port.

If your transaction device has network interfaces, make sure your device is connected to a 

network after configuring the IP settings. After the network settings have been configured, 

set up your device as a TCP server and make sure data can be transmitted to a specific port. 

Surveillance Station will receive data as a TCP client from the specified port. If you wish to 

develop your own software for more control on data transmission, it is recommended to 

use Surveillance Station WebAPI to transmit data since setting filter rules for raw transaction 

data will not be required when using Surveillance Station WebAPI. However, some traditional 

transaction devices only provide COM ports for data transmission. Selected Synology NVR 

devices also provide you the option to transmit data to Surveillance Station via a COM port. To 

receive data from the device, you only need to connect the device via COM port. If you want 

to transmit data over the network with devices with COM ports only, you can reference other 

third-party solutions for serial over LAN transferring.

Installation
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Note: Currently, only selected Synology NVR models provide COM port interface (e.g. 
NVR1218).

Add Transaction Devices in Surveillance Station

The following steps demonstrate how to add transaction devices in Surveillance Station if your 

device is able to properly connect to Surveillance Station.

Enable Transactions service

Enable Transactions in the Add-ons application before operating transaction devices. 

Transactions can be installed in Surveillance Station on every NAS/NVR models for free, but 

adding transaction devices will require additional device licenses. Please refer License for 

more information.

Set up the Transactions source of transaction devices

Launch the Transactions application and choose to add a transaction device. You may select 

POS, Third-party software, or AXIS Barcode Reader from the Transactions source drop-

down menu in the Add Transaction Device Wizard window. The first two options are used 

for identifying the device and will not affect the connection type or other settings. However, 

the option AXIS Barcode Reader will force select Surveillance Station WebAPI as the connection 

type since the camera application sends data through Surveillance Station WebAPI.
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Set up the connection type of transaction devices

Launch the Transactions application and choose to add a transaction device. In the Add 
Transaction Device Wizard window, you can determine the connection type of your 

transaction device. There are three options provided, TCP, Serial Port and Surveillance 
Station WebAPI. When selecting TCP from the Connection type drop-down menu, you will 

be required to set up the IP address and the corresponding port of the transaction device. 

Surveillance Station will receive data from this specified port.
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When selecting Serial Port from the Connection type drop-down menu, you will be required 

to set up port related settings, which are to be consistent with your device.

When selecting Surveillance Station WebAPI from the Connection type drop-down menu, 

you will also be required to set up the IP address and the specified port. However, unlike TCP, 

Surveillance Station WebAPI does not receive raw data from the IP address and port. These are 

only used to detect whether the device is still active or not. Surveillance Station receives raw 

data from the device via the WebAPI Synology provided. For more information, please refer to 

Chapter 6: Send Transactions Using WebAPI.
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After completing the connection settings, you can click Next to set up parsing rules for the 

received raw data if you have selected TCP or Serial port for your device.

Data Definition

The following steps only apply to setting up filter rules for raw data over TCP and Serial Port 

connection. If Surveillance Station WebAPI is used as the connection type for the transaction 

device, please go to Set up the display style to set up display options.

The purpose of data definition is to convert raw transaction data into coherent and structured 

information. You can omit or replace unwanted or redundant characters by setting up 

rules to filter and transform raw data into understandable text which are to be displayed 

on the screen. With this feature, you can precisely indicate the beginning and end of every 

transaction.

1.	 In Data Definition, you can start to collect raw data through the connection settings 

configured in the previous step by switching on Start Collecting Raw Data.

2.	 Please choose the correct encoding method for the received data before you start to 

transmit raw data to Surveillance Station. Choosing the wrong encoding method may result 

in the system failing to recognize the data and thereby unable to receive data. Although the 

system can automatically detect possible encoding methods upon receiving incoming data, 

the detected encoding method may not be 100% correct. Specifying the correct encoding 

method of your device before starting to transmit data is recommended.

3.	 The raw data that Surveillance Station received will be displayed in the Raw data area. You 

can set up parsing rules according to the received data. The transaction records will be 

filtered by the parsing rules and displayed in the Filtered data area.

4.	 The Start of transaction, End of transaction, and Canceling of transaction strings are 

the most important filer rules that should be set up first, since these are used to indicate 

the beginning and end of a transaction. When the received raw data contains strings that 

match Start transaction, Stop transaction, or Cancel transaction strings, a transaction record 

that includes data from the beginning to the end of a transaction will be automatically 

generated and stored in Surveillance Station. In addition, you can also add rules to mark 

certain strings as other text, replace certain strings with line breaks, or ignore certain 

strings.

5.	 Besides using strings in plain text, you can also use regular expression as the parsing rule 

for the Start of transaction, End of transaction, and Canceling of transaction strings. 

Compared with ordinary strings, regular expressions provide a more flexible format to 

represent a string. The following are examples of some of the most commonly used regular 

expressions:

1.	 If you want to parse a string in the date format of "yyyy-mm-dd", you can use the 

following regular expression:

•	 	[0-9]{4}-[0-1][0-2]-[0-3][0-9] or \d{4}-\d{2}-\d{2}

Note: In the regular expression above, "[0-2]" represent digits from 0 to 2, "\d" 
represents normal digits from 0 to 9 and {4} means to repeat the previous character 
4 times.
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2.	 If you want to parse a string in the format of "Cash    $dddd", you can use the following 

regular expressions:

•	 Cash.*\$\d+

Note: In this regular expression, "." represents any characters other than "\n", 
and "*" means the previous character repeats 0 or more times. Therefore, the 
combination ".*" can parse any string formats. "\$" represents the character "$". 
Since the character "$" has a special meaning in regular expression, we need to add 
an additional "\" before "$" to take away its special meaning. The character "+" means 
the previous character repeats 1 or more times.

6.	 Regular expressions provide highly flexible formats to represent strings. In this article, we 

have only given you some less complicated examples. Please refer to other online resources 

for more information on regular expressions.

7.	 After you finish setting up the parsing rule settings, the Filtered data area will show the 

transactions list by list, and the text in the Raw data area will have a different appearance. 

Different styles in the area represent different meanings as follows:

1.	 Bold: The strings are currently shown in the Filtered data area.

2.	 Blue: The matched strings parsed by the Start of transaction, End of transaction and 

Canceling of transaction rules.

3.	 Black: The normal strings that does not match any rules.

4.	 Gray: Represent the control characters defined in ASCII or the strings be filtered by rules.

For more information on the control characters defined in ASCII, please refer to this 

website.

8.	 You can click Next to pair cameras and set up the display options after you finished setting 

up parsing rules.

Set up the display style

The following steps will show you how to pair a camera for the transaction device, and 

modulate the display style of the text to be displayed on screen.

1.	 Under the Paired Camera section in the Add Transaction Device Wizard window, you 

can decide whether or not to pair a camera to a transaction device. If you choose to pair a 

camera to a transaction device, the pairing camera can be selected from the cameras that 

are added in Surveillance Station, and you can determine which stream profile to record 

when transactions occur. You can watch live view streams of the paired camera while 

overlaying transaction data in the Live View application. Video images of the paired camera 

during transactions will be automatically recorded and stored. If you enable the CMS service 

in Surveillance Station, the paired camera must be on the local server. If you choose not to 

pair a camera, the data receiving function will not be affected.

2.	 Under the On-Screen Display section in the Add Transaction Device Wizard window, you 

can modulate the display style of the text to display on screen. Any changes you modify will 

immediately be displayed on the right-hand side of the screen, which is the snapshot taken 

from the paired camera. You can effortlessly adjust and select a desired display style.

http://ascii.cl/control-characters.htm
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3.	 After all the settings are finished, click Finish to complete the setup process. After 

completing the setup, you can go to Transactions > Device, select a device and click on the 

play button to preview.

User-defined events

After you have added a transaction device, you can set up event detection based on the 

matching strings from the transactions. When the received transaction data contains strings 

you have defined, Surveillance Station will trigger the corresponding event. These events 

can be used in other applications like Notification or Action Rule to send notifications or 

trigger other actions. For more information, please refer to Live View Alert, Action Rule, and 

Notification.

You can go to Transactions > Edit > Event to set up matching strings for the events.
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Surveillance Station provides five sets of events for users to set up. Matching Type can be set 

as Plain text or Regular Expression. Plain text means normal strings and Regular Expression 

refers to the regular expression mentioned in Data definition. Note that the strings are 

matched based on the raw data instead of the filtered data.In-House Expertise

Advanced transaction settings and on-screen display

1.	 In addition to setting up user-defined events, after the transaction device is added, you can 

go to Transactions > Edit > Advanced to set up Transaction Settings and Live View On-
Screen Display.

2.	 If your device is connected using Surveillance Station WebAPI, only Live View On-Screen 
Display will be available since there are no Start of transaction, End of transaction, or 

Canceling of transaction marked in Data Definition to be omitted when sending data via 

WebAPI.
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3.	 Start of transaction, End of transaction, and Canceling of transaction corresponds to 

the settings in the Data Definition page. You can choose which of these you would like to 

omit in Live View and Historical Record.

4.	 If the strings you want to omit is defined in regular expression, the Live View on-screen 

display will be shown after the transaction is completed. The result of omitting Start of 
transaction and End of transaction is shown in image 

below.
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5.	 Go to Transactions > Edit > Advanced, and under the Live View On-Screen Display 

section, you can set up the Retain for (seconds) and Clear method options. In the Retain 
for (seconds) field, you can customize the duration that the transaction data will be 

retained on-screen when there are no new messages, the duration must be within 1 to 600 

seconds.

6.	 From the Clear method drop-down menu, you may choose in what condition other than 

time to clear the on-screen display text.

7.	 If you select On receiving next transaction, the on-screen display text will be cleared upon 

the start of a new transaction  If you select On receiving instruction, an additional text 

field will appear under Clear method, and in this field you can customize instructions for 

clearing the on-screen display text. 
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8.	 Once the instructions you have set up has been received, the transaction data on screen 

will be cleared immediately.

Delete Transaction Devices

Please refer to the following steps to delete transaction devices. 

1.	 To delete transaction devices, select the transaction device to be deleted, and click the 

Delete button. During the deleting process, you can choose whether or not to keep 

transaction records generated by the device.
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2.	 If you choose to keep all transactions, the deleted transaction device will remain on the 

transaction device list, but the status will be marked as Deleted.
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Transactions historical records

View Historical Records

Please refer to the following to view historical records.

1.	 Go to Transactions > Historical Records to review the transaction records generated by 

your devices. You can do the following in the Historical Records tab:

•	 Lock: Click the Lock button to lock certain transaction records. Unless you delete the 

corresponding device, you can never delete a locked record.

•	 Delete: Click the Delete button to delete the selected transaction records.

•	 Generate Report: Click the Generate Report button to generate reports of the selected 

records in HTML format.

2.	 Surveillance Station provides a search function to help you quickly find transaction records. 

The search filters you can set up are as follows:

•	 Status: Search for transaction records with statuses marked as Complete, Canceled or 

Incomplete.

•	 Date & Time: Search for transaction records that have occurred during a particular 

period of time.

•	 Keyword: Search for the contents of the transaction records including the matched 

strings.

3.	 You can view contents, time, and corresponding device names from the list of transaction 

records. To read the complete transaction contents in text, click the More button on the 

right-hand side to open the Transaction Detail window.

4.	 The complete transaction contents, generated time, and the corresponding device names 

are shown in the Transaction Detail window. You can switch between different transaction 

records quickly and play the corresponding video clips by clicking the Play button on 

the lower right corner. For Local Display and Surveillance Station Client, the control 

characters will not be shown in this window. You can also play videos on the list by clicking 

the play button on the thumbnail to launch Transaction Player.
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5.	 For the devices that are not paired with cameras, a 5 second long video with a default image 

with text overlaid will be played.
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6.	 For devices that are paired with cameras, the video clip during the transaction will be 

played.

7.	 The length of the recorded video is determined by Pre-recording time and Post-recording 
time of the paired camera, you can adjust the settings in IP Camera > Edit > Recording 
Settings > Recording.



19

Transactions historical records

Set up Archive Settings

You can set up rotating rules, including the number of days to keep logs and video clips, 

the maximum transaction record size to be kept, and whether to delete transaction 

records automatically under the Rotation Rules section in the Archive Settings tab of the 

Transactions application.

Note: 
1.	 The number of days to keep video clips cannot exceed the number of days to 

keep logs. After the transaction records have reached the rotation criteria, you 

can choose to archive records instead of deleting them.

2.	 Archive Settings only keep the text contents of the transaction records 

without including video recordings.

You can also customize share folders to store the recordings. Only the share folders created or 

added in Surveillance Station can be used for keeping recordings.



20

Applications
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Transaction devices added in Surveillance Station can interact with other applications in 

Surveillance Station to provide more useful functions. This chapter introduces how to set up 

the transaction device settings in other applications.

Live View

Users can include transaction devices in the layout in the Live View application by editing the 

layout in Live View Layout Management, in order to watch live feeds of the paired camera 

with overlaid transaction data.

You can see live view streams of the paired camera in the transaction device region. The 

received transaction text will be overlaid on the screen using the style that has been set up, 

please refer to Set up the display style.

If the text exceeds the screen range, the oldest messages will be rotated out of the screen. By 

default, the screen will be cleared automatically if no data is received within 10 seconds. You 

can also temporarily hide the received text by clicking the on-screen display button below.

Live View Alert

Events from transaction devices, including New Transaction Received and User-Defined 
Events, can also trigger alert events under Alert Management in the Live View application, 

in order to notify you that abnormal transactions might have occurred while you are watching 

video streams in Live View. 

When alert events are detected, you can watch recorded videos in the Alert History tab in 

Live View > Alert Management.

Events triggered by the camera, such as digital input events, motion events, and other 

events will usually remain triggered for a period of time. However, transaction events are 

triggered upon detecting certain keywords from the raw data received, and therefore will not 

remain triggered for a longer period of time. You will see that the duration for all transaction 

events are no longer than 1 second. However, when you play back the transaction events, 

an additional 10 second footage before the triggered event and 20 second footage after the 

triggered event will be played. You cannot play transaction events if there is no camera paired 

with the transaction device.
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Action Rule

You can also set up transaction events in the Action Rule application in order to trigger actions 

in response to possible abnormal transactions. To use transaction device events, please select 

the Triggered option from the Rule type drop-down menu when adding an action rule in Add 
Action Rule Wizard.

Select Transaction Device from the Event source drop-down menu under Event, in Add 
Action Rule Wizard, the transaction device you have added to Surveillance Station will be 

shown in the Device field. If you want to detect more than one event, click the Add button to 

add more events.

You can see detailed information under the List tab in Action Rule after finishing the action 

rule setup.

Notification

You can set up transaction events in the Settings tab of the Notification application in order 

to send real-time notifications to managers or guards when possible abnormal transactions 

occur. You can receive notifications via e-mail or mobile messages once transaction events are 

triggered.

You can go to Notification > Settings, select an event and click the Edit button to edit the 

message content to be delivered.
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You can go to Notification > Settings, select an event and click the Edit Schedule button to 

specify the notification schedule for each transaction device.
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Transaction privilege

This chapter will introduce the privilege settings of Transactions. Please note that the each 

user privilege settings of Transactions are applied to all transaction devices, not individual 

devices.

Manager

Go to Users, select a Manager user and click the Privilege button. Then go to the Advanced 

tab to adjust the following privilege settings for Transactions: 

•	 View transactions: The privilege to view transactions. If users do not have this privilege, 

they will not be able to use the Transactions application.

•	 Edit transaction device: The privilege to edit transaction devices.

•	 Add / Delete transaction device: The privilege to add and delete transaction devices.

•	 Enable / Disable transaction device: The privilege to enable and disable transaction 

devices.

•	 Edit archive settings: The privilege to edit the archive settings.

•	 Lock / Unlock transactions: The privilege to lock and unlock transaction records.

•	 Clear transactions: The privilege to clear the transaction records.

•	 Download logs: The privilege to download transaction record reports.
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Spectator

Go to Users, select a Spectator user and click the Privilege button. Then go to the Advanced 

tab to adjust the following privilege settings for Transactions:

•	 View transactions: The privilege to view transactions. If users do not have this privilege, 

they will not be able to use the Transactions application.

•	 Lock / Unlock transactions: The privilege to lock and unlock transaction records.

•	 Download logs: The privilege to download transaction record reports.

Paired Camera

If you do not have privileges to access live view streams of the paired camera, the default 

image with overlaid text will be displayed for the transaction device in Live View.
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If you do not have privileges to play back recordings of the paired camera, the default image 

will be shown for the thumbnails in the list in Historical Records and Transaction Player.

However, not having privileges to the paired camera will not affect receiving, displaying, and 

recording of transaction data.
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Send Transactions Using WebAPI

You can transmit transaction data from transaction devices added in Surveillance Station using 

Surveillance Station WebAPI, the WebAPI provided by Surveillance Station. In this chapter, 

we will provide detailed instructions on how to use Surveillance Station WebAPI to transmit 

data.

Note: If you wish to connect with the transaction device on the recording server, 
please send WebAPI directly to the recording server instead of the host server.

Authentication

Authentication is required before using any WebAPI provided by Synology. For more 

information on the login process, please refer to 2.1.2 Operation flow and 2.3.2 SYNO.API.
Auth in this document.

For API methods related to sending transactions, you can specify account and password as 

parameters to log in to NAS directly. 

API format

Synology WebAPI requests are implemented based on HTTP format. All the transaction 

operations are defined under the WebAPI, SYNO.SurveillanceStation.Transactions.
Transaction. Therefore, the basic request format is as follows:

http//{ip}:{port}/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.Transactions.Transaction&me

thod=<METHOD>&version=<VERSION>[&<PARAM_LIST>]

Tag Description

<METHOD> Method of API

<VERSION> Version of API

<PARAM_LIST> Parameter list for the method of API

An example for canceling a transaction:

http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.Transactions.Transact

ion&method=Cancel&version=2&deviceName=POS01&sessionId=1

https://global.download.synology.com/download/Document/Software/DeveloperGuide/Package/SurveillanceStation/All/enu/Surveillance_Station_Web_API.pdf
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API method list

Surveillance Station provides four methods to handle the transaction transmission.

Insert

This method is used to insert a complete transaction into Surveillance Station.

•	 Request

Parameter Description Value Version

dsName
Optional.The name of the 
CMS recording server which 
the transaction device is on. 

<string>, i.e. 
"NVR_1F"

2 and above

deviceName
The name of the transaction 
device added in Surveillance 
Station.

<string>, i.e. 
"Device01"

2 and above

content
The content of the whole 
transaction. 

<string>, i.e. "1234" 2 and above

format

The format of the content. 
"json" indicates the content 
is of JSON format. "string" 
indicates the content is pure 
text.

<string>, 
i.e. "string"

2 and above

timestamp

Optional. The number of 
seconds that have elapsed 
from 00:00:00 Coordinated 
Universal Time (UTC), 
Thursday, 1 January 1970 to 
the occurrence time of the 
transaction.

<integer>,  
i.e. 1508989055

2 and above

account
Optional. The login account 
name for NAS.

<string>,  
i.e. "Manager"

2 and above

password
Optional.  Password of the 
account.

<string>,  
i.e. "000000"

2 and above

•	 Example:

http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.Transactions.Transact

ion&method="Insert"&version=2&deviceName="POS01"&content="1234"&format="string"

•	 Response:

Status JSON Format Content

Success {"success":true}

Failed {"error":{"code":<ERROR CODE>},"success":false}

Please refer to API Error Code for more information about the error codes.
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Cancel

This method is used to cancel a session with the ID specified in sessionId. A session will end 

and a transaction labeled as Canceled will be generated after this request has been sent. Any 

data carried by the AppendData method with the same sessionId afterwards will be dropped 

and error will be reported.

•	 Request:

Parameter Description Value Version

dsName
Optional. The name of the CMS 
recording server which the 
transaction device is on. 

<string>,  
i.e. "NVR_1F"

2 and above

deviceName
The name of the transaction 
device added in Surveillance 
Station.

<string>,  
i.e. "Device01"

2 and above

sessionId ID of a session.
<string>,  
i.e. "1234"

2 and above

timestamp

Optional. The number of seconds 
that have elapsed from 00:00:00 
Coordinated Universal Time (UTC), 
Thursday, 1 January 1970 to the 
occurrence time of the transaction.

<integer>,  
i.e. 1508989055

2 and above

account
Optional. The login account name 
for NAS.

<string>, 
i.e. "Manager"

2 and above

password Optional.  Password of the account.
<string>, 
i.e. "000000"

2 and above

•	 Example:

http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.Transactions.Transact

ion&method="Cancel"&version=2&deviceName="POS01"&sessionId="1"

•	 Response:

Status JSON Format Content

Success {"success":true}

Failed {"error":{"code":<ERROR CODE>},"success":false}

Please refer to API Error Code for more information about the error codes.AppendData
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AppendData

This method is used to carry data into the session with the ID specified in sessionId.

•	 Request:

Parameter Description Value Version

dsName
Optional. The name of the CMS 
recording server which the 
transaction device is on. 

<string>, i.e. 
"NVR_1F"

2 and above

deviceName
The name of the transaction 
device added in Surveillance 
Station.

<string>, i.e. 
"Device01"

2 and above

sessionId ID of a session. <string>, i.e. "1234" 2 and above

content

The transaction content. The 
contents sent by one request 
would be regard as one line. 
Users can also carry "\n" in the 
contents to break lines.

<string>, 
i.e. "Start\
n2017/01/01"

1 and above

timestamp

Optional. The number of seconds 
that have elapsed from 00:00:00 
Coordinated Universal Time 
(UTC), Thursday, 1 January 1970 
to the occurrence time of the 
transaction.

<integer>, 
i.e. 1508989055

2 and above

account
Optional. The login account 
name for NAS.

<string>,  
i.e. "Manager"

2 and above

password
Optional. Password of the 
account.

<string>, 
i.e. "000000"

2 and above

•	 Response:

Status JSON Format Content

Success {"success":true}

Failed {"error":{"code":<ERROR CODE>},"success":false}

Please refer to API Error Code for more information about the error codes.API Error Code



30

Send Transactions Using WebAPI

API error code

Code Description

400 Operation failed

401 Illegal parameters

Operation failed means the system is in an abnormal status. Please confirm that the 

Transactions service is enabled in the Add-ons application. If the service has been enabled, 

please try to restart Surveillance Station.

Several reasons can cause Illegal parameters, here are some common reasons listed as 

follows:

•	 Incomplete or invalid parameters.

•	 Tried to append, complete, or cancel a session before it started.

•	 The sessionId does not match any existing sessions.

•	 The deviceName is not found in Surveillance Station.

•	 The timestamp of AppendData, Complete, or Cancel is less than the timestamp of Begin in 

one of the sessions.

Examples

•	 Start a transaction: http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.

Transactions.Transaction&method="Begin"&version=2&deviceName="POS01"&sessionId="1

"&timeout=300

•	 Append data: http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.

Transactions.Transaction&method="AppendData"&version=2&deviceName="POS01"&sessio

nId="1"&content="Start\n2017/01/01"

•	 Append data: http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.

Transactions.Transaction&method="AppendData"&version=2&deviceName="POS01"&sessio

nId="1"&content="Pen $40\nBook $300"

•	 Append data: http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.SurveillanceStation.

Transactions.Transaction&method="AppendData"&version=2&deviceName="POS01"&sessio

nId="1"&content="Total $340\nEnd"

•	 Complete a transaction: http://192.168.2.3:5000/WebAPI/entry.cgi?api=SYNO.

SurveillanceStation.Transactions.Transaction&method="Complete"&version=2&deviceName

="POS01"&sessionId="1"
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Note: 
•	 If your Synology NAS is a CMS Host server, you can specify dsName to 

designate a CMS recording server which the transaction device is on. If dsName 

is not specified, the CMS Host server is first searched before CMS recording 

servers for transaction devices matching the given name. If two or more CMS 

recording servers connects to transaction devices matching the given name and 

dsName is not specified, the command will be ignored.

•	 sessionId is used to distinguish between different transaction events. The 

same deviceName and sessionId will be treated as the same record. If the 

same parameter is sent again, the Begin method will be ignored until the 

transaction has completed, canceled, or exceeded transaction time limit. After 

that, sessionId can be reused.

•	 After the start of the transaction, if the time limit is exceeded before receiving 

the Complete or Cancel methods, the transaction record will be saved and 

marked as Incomplete.

•	 timestamp is in UTC format, you can use https://www.epochconverter.com/ 

to convert the current time to timestamp or check if the timestamp is correct.

https://www.epochconverter.com/


32

Troubleshoot

Troubleshoot

Why is my device always disconnected?

If your device was connected using TCP or WebAPI, please make sure your device is still 

connected to Surveillance Station. You can check the firewall settings and try to ping the 

devices from your NAS. Another possible reason for disconnection is that your device is not 

working as a TCP server to transmit data over TCP connection. Please check the TCP settings 

on your device.

Why can't I receive data?

Please make sure you can receive data properly. Go to the Transactions application, select 

a transaction device and click Edit, then go to the Data Definition tab and turn on the Start 
Collecting Raw Data switch. Make sure your device starts to deliver data to your NAS and that 

the data you have sent can be displayed on the screen. If no data is received, please check if 

your device is still connected and the encoding method is correct. If your device is connected 

over Serial Port, check if the COM port setting is correct. 

If you are using WebAPI as the connection type, please check if there are any error codes 

returned back or if there are any typos in the deviceName or dsName WebAPI command.

How do I set up the correct data definition?

Go to the Transactions application, select a transaction device and click Edit, then go to the 

Data Definition tab and turn on the Start Collecting Raw Data switch. Send your data to 

NAS and see if the strings defined by your parsing rules are marked in blue in the Raw data 

area. Also, check if the data can convert into transaction records in the Filtered data area.

The paired camera does not record when a transaction event occurs

Go to the IP Camera application, select the paired camera and click Edit. Please make sure 

the Disable recording and rotation checkbox is not ticked in the Advanced tab in Recording 
Settings.
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The user-define event was set but not triggered

The user-define events should be triggered on all the applications, including Live View Alert, 

Notification, and Action Rule. If the user-define event is only triggered correctly on selected 

applications, then the other applications might have some issues. Please contact Synology 

support to solve this problem.

If the user-define event is not triggered on all the applications, please go to Transactions, 

select the transaction device and click Edit, then go to the Data Definition tab to check 

whether the plain text or regular expression matching works properly. If plain text matching 

does not work, please contact Synology support to solve this problem. If you are using regular 

expression, please check whether the usage of the regular expression is correct.

Useful regular expressions

To parse dates in a format of "yyyy-mm-dd":

•	 [0-9]{4}-[0-1][0-2]-[0-3][0-9]

To parse strings including "Tea" or "Coke":

•	 Tea|Coke

To parse strings including "the", "that", or "this":

•	 th(e|at|is)

To parse strings in the format of "Cash    $dddd":

•	 Cash.*\$\d+

To parse the string "open" and not match with "opener":

•	 ^open$

To parse numbers greater than 1200:

•	 ^0*([1-9]\d{4,}|[2-9]\d{3}|1[3-9]\d{2}|12(?!00)\d{2})$

Pattern Description

[0-9] Matches characters from 0-9

{4} Matches previous character four times

{4,} Matches previous character at least four times

. Matches any characters except "\n"

* Matches previous character zero or more times

+ Matches previous character zero or more times

| Matches any elements separated by a vertical bar

\d Matches characters from 0-9

^ The match must occur at the beginning of a word

$ The match must occur at the end of a word

(?!abc) Skips match for the pattern abc
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